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 ه ییقوه قضالینک های مفید آزمون استخدامی 

 منابع آزمون خرید سوالات قوه قضاییه )کادر اداری( 

 کارشناس شبکه خرید سوالات خرید سوالات تقریر نویس

 ی امور دفتر ی متصد خرید سوالات اطلاعات  ی کارشناس فناور خرید سوالات

 خرید جزوه عمومی آزمون  مسئول ابلاغ و اجرا  خرید سوالات

 اخبار آزمون سال اخیر 10سوالات استخدامی 

 عرضه  رانیا  یاجتماع یشبکه ها
  + اخبار(   یهفتگ فاتی + تخف گانیرا  ی ها لی)فا

 (       )برای مشاهده هر بخش روی آن بزنید      

https://iranarze.ir/es278
https://iranarze.ir/blog/estekhdam1051/
https://iranarze.ir/es1570
https://iranarze.ir/es1569
https://iranarze.ir/ES1573
https://iranarze.ir/page/social-networks
https://iranarze.ir/page/social-networks
https://iranarze.ir/es580
https://iranarze.ir/es1572
https://iranarze.ir/es1571
https://iranarze.ir/es1568
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سوالات  دی+ کل 1396 هییقوه قضا یسوالات استخدام فهرست    

 فهرست مطالب 

 سوال( 100) 4صفحه   - 1396آذر  هییقوه قضا یشده آزمون استخدام  پ یفصل اول: سوالات تا ❖

 هوش و توانمندی عمومی   -زبان انگلیسی  -معارف اسلامی  -زبان و ادبیات فارسی  -اطلاعات  یفناور

 21صفحه  - 1396 آذر  هییقوه قضا یسوالات آزمون استخدام دیفصل دوم: کل ❖
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 1396آذر  هییقوه قضا یشده آزمون استخدام پی فصل اول: سوالات تا ❖

   مهارت های هفتگانه( فناوری اطلاعاتICDL ) 

 شود؟ در یک سیستم کامپیوتر، کدام جزء بر روی برد اصلی نصب نمی  -1

 ( منبع تغذیه ۲    ( واحد پردازنده مرکزی ۱

 RAM( حافظه  ROM     ۴( حافظه  ۳

 »هرتز« واحد چیست؟  -۲

 ( سرعت انتقال داده به دیسک سخت ۱

 ( سرعت انتقال داده به یک حافظه جانبی ۲

 ( تعداد پیکسل های نمایش داده شده در هر ثانیه ۳

 CPU( سرعت  ۴

 کدام مورد، با موارد دیگر، متفاوت است؟  -۳

 ( اسکنر ۴  ( قلم نوری۳  ( ماوس ۲   ( چاپگر۱

فایل هایی از انواع زیر در پوشه این برنامه قرار خواهند گرفت.    Windows 7پس از نصب یک برنامه بر روی سیستم عامل    -۴

 اجرای کدام نوع فایل موجب اجرای برنامه خواهد شد؟ 

Application 

GIF File 

Icon 

File Folder 

۱ )File Folder  ۲ )GIF File  ۳ )Icon   ۴ )Application 

، یک پنجره فعال باشد. می خواهید فقط از همین پنجره فعال یک عکس تهیه کنید. از  Windowsفرض کنید در محیط    -۵

 کدام مورد زیر کمک می گیرید؟

۱ )File+ Print     ۲ )Ctrl+P   

۳ )Alt+ Print Screen    ۴ )Ctrl+F 

 کدام کلید، برای تغییر دادن نام یک فایل یا پوشه انتخاب شده، مناسب است؟  -۶

۱ )F1   ۲ )F5   ۳ )F2   ۴ )F9 

، تعداد نتایج یافت شده پس از جستجوی کلمه »شهر« در عبارت زیر، یک عدد بوده است. کدام مورد Wordدر نرم افزار    -۷

 انتخاب شده است؟  Findدر پنجره 

https://iranarze.ir/es278
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»به طور کلی، تعداد کتابسراهای علمی در سطح شهرها و شهرستان ها افزایش داشته است. این در حالی است که در شهر  

 تهران، روزانه یک کتابسرا بسته می شود.« 

۱ )Find Whole Words Only   ۲ )Use Wild Cards 

۳ )Match Prefix    ۴ )Match Case 

 مورد است؟ ی کدام معنا به خطکش، در  ⌋، علامت Wordدر نرم افزار  -۸

 های تنظیم شده در سند  Tab( ۲   ( حاشیه تنظیم شده در سند۱

 ( موقعیت مکان نما ۴    ( موقعیت درج شکل ۳

 ، برای نمایش گرافیکی داده ها از کدام مورد استفاده می شود؟ Word 2007در محیط  -۹

۱ )Table  ۲ )Clip Art  ۳ )Smart Art  ۴ )Cart 

 ”، کدام حالت ترازبندی را ایجاد می کند؟Justifiyقرار دادن ابزار ترازسازی در حالت “ Word 2007در یک سند  -10

 ( از راست ۴  ( وسط چین ۳  ( دو طرفه ۲  ( از چپ ۱

 اگر بخواهیم یک کاربرگ در موقع چاپ در اندازه واقعی کاربرگ چاپ شود، از کدام ابزار استفاده می شود؟  -11

۱ )Scale     ۲) View> Custom 

۳ )View> Zoom to selection   ۴ )Size 

 کدام است؟   Excel 2007در محیط   Print Areaکاربرد ابزار   -1۲

 چاپ نمودار ایجاد شده از داده های موجود در یک کاربرگ( ۱

 Excelپیش نمایش صفحه به صفحه یک کاربرگ از یک فایل  ( ۲

 انتخاب یک محدوده مشخصی از کاربرگ برای پرینت گرفتن ( ۳

 تعیین بزرگترین محدوده ممکن جهت چاپ ( ۴

 # ظاهر می شود؟ NAMEدر کدامیک از موارد زیر، خطای ? -1۳

۱( )A2 A5) Sum    ۲ = )sum (A2,A5) 

۳ = )sum (A2:A5)    ۴(= )A2A5 ) 

در تمام صفحات تکرار شود، از کدام ابزار کمک می   ، اولین سطر کاربرگExcelاگر بخواهید به هنگام چاپ یک فایل    -1۴

 گیرید؟ 

۱ )Page Layout> Print Titles   ۲ )Home> Cells> Format 

۳ )Data> Text to Columns   ۴ )Home> Wrap Text 

 از کدام مورد زیر، کمک می گیرید؟ PowerPoint 2007جهت ترسیم شکل یک ستاره در یک اسلاید از یک فایل  -1۵

۱ )Insert> Picture    ۲ )Insert> WordArt 
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۳ )Insert> ClipArt    ۴ )Insert> Shapes 

  1۳و    1۲،  10اسلاید ایجاد کرده اید، فرض کنید در حین نمایش بخواهید اسلایدهای    ۵۲شامل    PowerPointیک فایل    -1۶

 نمایش داده نشود، مناسب ترین راه، استفاده از کدام ابزار است؟ 

۱ )Custom Slide Show    ۲ )Setup Slide Show 

۳ )Hide Slide     ۴ )From Current Slide 

 مرتب سازی رکوردها بر اساس کدام یک از موارد زیر، قابل انجام است؟  Accessدر محیط  -1۷

I حروف الفبا .II  عدد .IIIتاریخ و زمان . 

۱ )I ،II  وIII  ۲ )I  وII   ۳ )II  وIII  ۴ )I  وIII 

 به طور معمول، سازمان های دولتی از کدام دامنه برای آدرس اینترنتی خود استفاده می کنند؟ -1۸

۱ )edu   ۲ )gov   ۳ )com  ۴ )org 

 باشد؟  internet Explorerمرورگر  Historyکدام مورد می تواند دلیل عدم ثبت برخی از سایت های مشاهده شده در  -1۹

 InPrivate Browsing( استفاده از Proxy    ۲( استفاده از ۱

 ( درج دامنه اشتباه۴   ( حذف سایت ها از روی سایت ۳

 کدام پوشه در یک حساب کاربری ایمیل، از نوع پوشه های ورودی است؟  -۲0

۱ )Outbox  وSpam/junk   ۲ )Inbox  وTrash 

۳ )Inbox  وSpam/Junk   ۴ )Trash  وOutbox 

 زبان و ادبیات فارسی 

 معنی کدام واژه در مقابل آن، »غلط« آمده است؟  -۲1

 ( گردون: فلک ۲    ( بمسخرّ: دشواری ۱

 ( فرتوت: پیر ۴  ( کنام: محل زندگی جانوران وحشی۳

 شبرو« به ترتیب، کدام است؟  -معنی واژه های »وصُلت  -۲۲

 شب بیدار  -محکم (۲     نگهبان -( ارتباط۱

 راهزن  -( پیوستگی۴     کشیک -( پیوند۳

 در کدام گروه کلمه، »غلط املایی« یافت می شود؟   -۲۳

 دوران نقاهت  - و تأثیر پذیری تأثیر گزاری( ۲   عزلت و انزوا -( مضامین بدیع۱

 ذمت و تعهد  -مرفه طبقه( ۴  قواعد و ضوابط  -( درخواست المثنی۳ّ

 در کدام عبارت، »غلط املایی« وجود دارد؟   -۲۴
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 چه مناسبت است و تو را بدو چه مشابهت ( گفت ای سفیه، شتر را با تو ۱

 ( در این هفته که مرده سلامت حجاج برسید از بند گرانم خلاص کرد. ۲

 سفر افتاد.   اتفّاق( در این قربت، مرا با طایفه ای باران ۳

 آن بینم که ملک قناعت را هراست کنی و ترک ریاست گویی.  تمصلح( پس ۴

 کدام مورد زیر، نام یکی از آثار معروف »عبید زاکانی« است؟  -۲۵

 ن امیر ارسلا( ۴  ( موش و گربه ۳ ( یکی بود، یکی نبود ۲  ( زن زیادی۱

 کدام اثر، از »نادر ابراهیمی« است؟  -۲۶

 ( نفرین زمین ۴ ( دهکدۀ پرملال ۳ ( فارسی شکر است ۲ ( آتش بدون دود ۱

 واژه های قافیه در بیت زیر، کدام است؟  -۲۷

 نالیدن از هزار بپرس و ز من مپرس«  »احوال گل ز خار بپرس و ز من مپرس           

 بپرس  -( بپرس۲    من مپرس  -( من مپرس۱

 ز من مپرس  -( زمن مپرس۴     هزار -( خار۳

 ابیات زیر، در چه قالبی سروده شده اند؟  -۲۸

 شرف از دل و جان کوشیم در راه  »ما باده عزت و جلالت نوشتیم                      

 آزادی را به بندگی نفروشیم«   گر در وصف رزم جامه بر تن پوشیم             

 ( قطعه ۴  ( چهارپاره۳  ( رباعی۲  ( دوبیتی۱

 در بیت زیر، کدام واژه »ایهام« دارد؟   -۲۹

 مسکین دلم به زحمت مردم رضا نبود«   »دوشم نخفت دیده به بالین دل ولی             

 ( مردم ۴  ( دوش ۳   ( دیده ۲   ( رضا۱

 آرایه های بیت زیر، کدام اند؟  -۳0

 »تا کی آخر چو بنفشه سر غفلت در پیش              حیف باشد که تو در خوابی و نرگس بیدار«

 ایهام  -پارادوکس -( استعاره۲    تضاد  -تشبیه -( کنایه۱

 تضاد  -کنایه  -( ایهام۴   کنایه  -پارادوکس -( تشبیه۳

 در بیت زیر، »آب از چشم گرفتن« کنایه از چیست؟  -۳1

 »مرد گزیده گر رمد از خلق دور نیست                  چشم تو آب چشم ز آهو گرفته است« 

 ( گریستن ۴ ( نهایت بدبختی۳ ( کار بیهوده کردن ۲  ( ترساندن۱

 کدام بیت، مفهومی نظیر بیت زیر دارد؟   -۳۲

 هرگز نکند در گرانمایه به چنگ«  »غواص گر اندیشه کند کام نهنگ                           



 

 
8 

1396 هییقوه قضا: 1فصل   سوالات  دی+ کل 1396 هییقوه قضا یسوالات استخدام   

 ( ای دل غمدیده حالت به شود دل بد مکن              وین سر شوریده باز آید به سامان غم مخور ۱

 ( دور گردون گر دو روزی بر مراد ما نرفت                دائماً یکسان نباشد حال دوران غم مخور ۲

 هان مشو نومید چون واقف نه ای از سر غیب        باشد اندر پرده بازی های پنهان غم مخور ( ۳

 ( در بیابان گر به شوق کعبه خواهی زد قدم              سرزنش ها گر کند خار مغیلان غم مخور ۴

 مفهوم کدام بیت با سایر ابیات، تفاوت دارد؟  -۳۳

 ( نخواستم که بگویم حدیث عشق و چه حاجت         که آب دیده سر خم بگفت و چهره زردم ۱

 ( ای بی نشان محض نشان از که جویمت                گم گشت در تو هر دو جهان از که جویمت ۲

 ( چه حاجت است به اظهار عشق پیش تو ما را        که اشک گوید و رخسار زرد و رنگ پریده ۳

 ( سر سودای تو در سینه بماندی پنهان                   چشم تر دامن اگر فاش نکردی رازم۴

 بیت زیر، با کدام بیت، ارتباط مفهومی دارد؟  -۳۴

 »دود اگر بالا نشیند کسر شأن شعله نیست           جای چشم ابرو نگیرد کوچه او بالاتر است« 

 غرقه در نیل چه اندیشه کند باران را  ( سعدی از سرزنش غیر نترسد هیهات                ۱

 ( بر سینه دل چه سود خواندن وعظ                    نرود میخ آهنین بر سنگ ۲

 ( نه هر که صدرنشین شد عزیز شد که غبار          اگر به دیده رسد توتیا نخواهد شد.۳

 ( باغ را بین چه غم که شاخ شکست                      باغبان راست غصه ای گر هست ۴

 کدام عبارت، نیاز به ویرایش دارد؟   -۳۵

 ( هنگام مد، آب دریا بالاتر است. ۲   ( آخرین مسابقه فینال را دیدم۱

 ( خورشید هنوز برنیامده است. ۴  ( او هیچ وقت دست از پا خطا نمی کند. ۳

 کدام عبارت نیاز به ویرایش دارد؟  -۳۶

 ( زبان متون ادبی گذشته، اندکی دشوار است. ۱

 قابل فهم باشد. ( زبان نوشته، باید ساده و ۲

 ( او روز گذشته از سمت خود استیفا داد ۳

 ( تعهدنامه از اسناد رسمی است که بین دو نفر یا بیشتر منعقد می گردد. ۴

 کدام عبارت گژتابی دارد؟ -۳۷

   ( آفتاب روشن در پرده نخواهد ماند۱

 ( هیچ دورانی از آدم های بزرگ خالی نیست ۲

 ( برترین نیروی آدمی، توانایی شناخت دنیاست ۳

 ( به دوست همسایه ام، سلام کردم. ۴
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 ساختمان کدام دو واژه، با سایر واژگان تفاوت دارد؟  -۳۸

 دانشکده -( شاخسار۲    خزانه دار  -( پایمرد۱

 جنگجو  -( یکدل۴    گلاب پاش  -( شهیر۳

 رابطه معنایی کدام واژه ها متفاوت است؟   -۲۹

 بعید و قریب  -( کهین و مهین۲   رزق و روزی  -( فرتوت و پیر۱

 لطیف و نیکو -( مهر و خورشید۴  گرانمایه و با ارزش  -( فروزان و تابان۳

 در کدام گروه، واژه های هم خانواده، »غلط« آمده است؟  -۳0

 مغتنم  -( غنی۴  قرائت  -( تقریر۳ بصیرت  -( مبصر۲  عزیز  -( عزت۱ّ

  معارف اسلامی 

 آیه شریفه »و فی الارض آیات للمومنین و فی انفسکم افلا تبصرون« به کدام موضوع اشاره دارد؟  -۴1

 ( سیر در زمین مقدمه خداشناسی است. ۲  ( خداشناسی مقدمه خودشناسی است ۱

 ( خودشناسی مقدمه خداشناسی است. ۴ ( معرفت نفس مقدمه خودشناسی است ۳

قرآن مجید که می فرماید: »خداست که با هدایت خویش چنان تدبیر می کند که گیاهان همواره، میوه های گوارا تولید   -۴۲

 کنند« به کدام تقریر از برهان نظم اشاره دارد؟ 

 ( هماهنگی در کل عالم ۲     ( هدفمندی ۱

 ( از موارد جزئی ۴    ( طراحی در کل عالم ۳

 با وجود کدام ویژگی ها در پرستش و بندگی محقق می شود؟  -۴۳

 ( حسن فعلی و صورت صحیح۲   ( حسن فاعلی و نیت الهی ۱

 ( حسن فعلی و اثر مفید ۴   ( حسن فاعلی و حسن فعلی۳

 ایمان راستینی که باعث سعادت آدمی می شود، کدام است؟  -۴۴

 ( ایمان توأم با عمل صالح ۱

 ( ایمان ناشی از اختیار و آزادی۲

 ( ایمان به وحدانیت خداوند و رسالت پیامبر ۳

 ( ایمان همراه با تعقل و تفکر۴

 آیات شریفه »الحمدلله رب العالمین« و »إیاک نعبد و إیاک نستعین« به ترتیب بیانگر کدام بعد از ابعاد توحید هستند؟   -۴۵

 افعالی -عبادی (۴ افعالی -( افعالی۳  عبادی -( عبادی۲  عبادی  -( افعالی۱

 موارد زیر، کامل کرد؟ خداوند نعمت هدایت را با وجود کدام یک از  -۴۶
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 ( انبیا و اولیای خود۲    ( پیامبر اکرم )ص( ۱

 ( انبیا و عقل بشری ۴    ( پیامبران اولوالعزم ۳

 سند و دلیل نبوت پیامبران چیست؟  -۴۷

 ( معجزه که به درخواست مردم تحقق می یافت. ۱

 ( وحی که از سوی خداوند، بر قلب پیامبر نازل می شد. ۲

 ( وحی که از سوی خداوند، برای هدایت بشر نازل شد. ۳

 ( معجزه که به اذن خدا انجام می شد.۴

 برترین و والاترین مقام پیامبر اکرم )ص( چیست و چگونه به این مقام نائل شدند؟ -۴۸

 عبودیت و بندگی در مسیر قرب الهی -( ولایت معنوی۱

 شایستگی خود پیامبر و عنایت الهی  -( ولایت ظاهری۲

 عبودیت و بندگی در مسیر قرب الهی -( ولایت ظاهری۳

 شایستگی خود پیامبر و عنایت الهی  -( ولایت معنوی۴

 تنها چه کسی می تواند فرد شایسته مقام امامت را معرفی کند و آیه ولایت، در شأن کدام معصوم است؟  -۴۹

 حضرت محمد )ص(  -خداوند متعال (۲  حضرت علی )ع(  -( حضرت محمد )ص(۱

 حضرت محمد )ص(  -حضرت محمد )ص( (۴  حضرت علی )ع( -( خداوند متعال۳

به کدام علت، خداوند آخرین حجت خود را در هنگام تولد از نظرها پنهان کرد تا امامت در شکل جدید و از پس پرده    -۵0

 غیبت ادامه یابد؟ 

 ( عدم آمادگی مردم برای تحقق وعده های الهی در مورد حکومت ۱

 ( عدم شایستگی مردم برای درک حضور و بهره مندی از ایشان ۲

 ( رواج گناه و ظلم و بی عدالتی در جامعه توسط حکومت ها ۳

 و ناسپاسی مردم و در خطر جان آن حضرت  قدر ناشناسی( ۴

با توجه به اینکه هزاران پیامبر که به راستگویی شهرت داشتند، به آدمی خبر داده اند که روز عظیم و واقعه ای تکان    -۵1

 دهنده و دنیایی دیگر در پیش است، عبارت »آیا انسان نباید احتیاط کند؟« به کدام برهان معاد اشاره دارد؟ 

 ( فطرت ۴  ( عدالت ۳  ( معقولیت ۲  ( حکمت ۱

به کدام    -۵۲ المتقین کالفجار«  أم نجعل  الصلاحات کالفمسدین فی الارض  الذین آمنو و عمولا  آیه شریفه »أم نجعل  از 

 موضوع پی می بریم؟ 

 ( امکان معاد در پرتو حکمت الهی ۲   ( ضرورت معاد در پرتو عدل الهی ۱

 ( امکان معاد در پرتو عدل الهی ۴  ( ضرورت معاد در پرتو حکمت الهی۳
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 ترجمه آیه شریفۀ »زندگی حقیقی همانا در سرای آخرت است. ای کاش می دانستید«. بیانگر کدام موضوع است؟  -۵۳

 ( غیرواقعی بودن زندگی دنیا و حقیقی بودن زندگی آخرت ۱

 ( جاودانگی زندگی اخروی همراه با معاد روحانی۲

 ( جاودانگی زندگی اخروی همراه با معاد جسمانی ۳

 ( حیات اخروی تقریباً شبیه دنیاست، لکن دارای کمال است. ۴

به ترتیب، چه کسانی و برای انجام دادن چه عملی، وقتی مرگشان فرا می رسد، آرزو می کنند که ای کاش به دنیا بر می    -۵۴

 گشتیم؟ 

 اعمال صالح  -( کافران و تبهکاران۲   توبه واقعی -( همه انسان ها۱

 توبه واقعی  -( کافران و تبهکاران۴   اعمال صالح  -( همه انسان ها۳

قرآن کریم در مورد کدام یک از شاهدان رستاخیز می فرماید: »هر انسانی وارد محشر می گردد، درحالی که همراه او   -۵۵

 سوق دهنده و گواهی دهنده ای است«؟ 

 ( پیامبر اسلام )ص( ۴  ( فرشتگان ۳  ( پیامبران الهی ۲  ( اعضا و جوارح۱

از ترجمه آیه شریفه »هرکس از یاد من )خدا( دل بگرداند، در حقیقت، زندگی تنگ خواهد داشت«، کدام مفهوم زیر    -۵۶

 دریافت می شود؟ 

 ( دین پشتوانه مستحکمی برای غلبه بر اضطراب های روانی است. ۱

 ( انسان با یاد خداوند می تواند به سعادت دنیوی و اخروی نائل گردد. ۲

 خدا و تعالیم پیامبران الهی است. ( ریشه بحران اخلاقی در انسان، غفلت از ۳

 ( دین همواره پشتوانه مستحکمی برای اخلاق بوده و هست. ۴

از ترجمۀ آیه شریفۀ »در حقیقت، خدا حال قومی را تغییر نمی دهد، مگر آنان خود حال خویش را تغییر دهند«، کدام   -۵۷

 مفهوم دریافت می شود؟ 

 جامعه، قوانین و سنت های عمومی می باشد که باید به آنها توجه کرد ( تغییر و تحول در امور مربوط به ۱

 ( شرط برقراری عدالت در جامعه، منوط به مبارزه جدی و همه جانبه گروهی از افراد جامعه است. ۲

 ( بسیاری از درد و رنج هایی که از ستمگران به مردم می رسد، ناشی از سطح نگری آنان است. ۳

 ( جامعه ای که گرفتار بی عدالتی شده، برای برقراری عدالت، همراهی عموم افراد جامعه را لازم دارد. ۴

 قرآن کریم، راه و روش اصلی کسب عزت و کرامت را چگونه معرفی می کند؟  -۵۸

 ( بازگشت به سوی خدا و قبول فرمان های او۲  ( از تمایلات پست درونی پیروی نکردن ۱

 ( توانایی انسان در کنترل شهوت جنسی ۴  ( تحقیر نکردن و کوچک نشمردن دیگران ۳
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قرآن کریم از قول حضرت ابراهیم )ع( می فرماید: »پروردگارا من یکی از فرزندانم را در دره ای بی گشت، نزد خانه محترم    -۵۹

 تو، سکونت دادم، تا …………………..«. 

 ( دین حق را به پا دارد ۲    ( خانه کعبه را آباد کند ۱

 ( نماز را به پا دارد. ۴    ( اطاعت خدا را کند ۳

 عالی ترین هدف تشکیل خانواده، کدام است؟  -۶0

 ( آرامش ناشی از انس و هم صحبتی بین همسران ۱

 ( کسب آمادگی پذیرش مسئولیت در خانواده ۲

 ( رشد اخلاقی و معنوی هر یک از اعضای خانواده ۳

 ( رشد و بالندگی فرزندان در همه ابعاد فرهنگی و دینی ۴

  عمومی  –سوالات درس زبان انگلیسی 

Part A: Grammar and Vocabulary 

Directions: Choose the word or phrase ()1), (2), (3), or (4) that best completes each sentence. Then mark 

the correct choice on your answer sheet 

61- The man over there is a famous architect ................. designs won an international award last year . 

1) whose  2) which  3) who’s  4) whom 

62- David ................. harder, but he was too lazy and that’s why he failed the exam . 

1) should study    2) should have studied 

3) must have studied    4) must study 

63- Maryam showed her father the most recent picture ................. by her little daughter . 

1) that painted  2) painted  3) was painted 4) it was painted 

64- The students bought some eggs and tomatoes ................. they would make an omelet . 

1) as soon as  2) until   3) so that  4) whether 

65- “Would you mind ................. in the nonsmoking section?” the security guard said politely . 

1) don’t smoke 2) not to smoke 3) not smoke  4) not smoking 

66- Mary will certainly lose all her friends if she ................. to talk about them behind their backs. 

1) continues  2) would continue 3) continued  4) will continue 

67- While I was sitting at the case with my friends, I suddenly realized that ............ the oven on at home . 
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1) was left  2) was leaving  3) had left  4) have left 

68- Children seem to learn more interesting things ................. to when we were at school . 

1) observed  2) compared  3) attached  4) investigated 

69- To stay competitive, they’ll have to increase product ................. as well as cutting prices . 

1) excitement  2) treatment  3) argument  4) development 

70- According to eye ................. the robbery was carried out by two teenage boys . 

1) employers  2) laborers  3) witnesses  4) partners 

71- Many important historical ................. were destroyed when the library was burned in fire . 

1) missions  2) temperatures 3) distances  4) documents 

72- My schedule is very ................., so I can arrange to meet with you any day next week . 

1) mild   2) flexible  3) global  4) aware 

73- The lawyer suspected that the judge was bribed to arrive at a guilty ................. 

1) conflict  2) entity  3) verdict  4) portion 

74- When you give a ................. everyone expects you to be telling the truth in whatever statement you 

are telling them . 

1) testimony  2) controversy  3) phenomenon 4) foundation 

75- When you’re working such long hours, it is ................. that your marriage will start to suffer . 

1) significant  2) voluntary  3) contemporary 4) inevitable 

Part B: Reading Comprehension : 

Directions: Read the following passage and select the choice (1), (2), (3), or (4) that best answers each 

question. Then mark the correct choice on your answer sheet 

Criminal law distinguishes crimes from civil wrongs such as tort or breach of contract. The distinction 

between criminal law and civil law has existed throughout history, Criminal law has been seen as a system 

of regulating the behavior of individuals and groups in relation to societal norms at large whereas civil law 

is aimed primarily at the relationships between private individuals and their rights and obligations under 

the law. Although many ancient legal systems did not clearly define a distinction between criminal and 

civil law, in England there was little difference until the codification of criminal law occurred in the late 
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nineteenth century. In most North American law schools, the basic course in criminal law is based upon 

the English common criminal law of 1750 

76- What is the passage mainly about ? 

1) The importance of criminal law 

2) Law schools in North America 

3) Differences between criminal law and civil law 

4) Criminal law in England 

77- The word “primarily” in line 4 means .................. 

1) previously  2) mainly  3) privately  4) frequently 

78- The word “their” in line 5 refers to .................... 

1) relationships 2) sights  3) obligations  4) individuals 

79- Which of the following statements is true ? 

1) The codification of criminal law in England resulted in the distinction between criminal and civil laws. 

2) The codification of criminal law in England occurred in the late nineteenth century . 

3) The distinction between criminal and civil laws has never existed historically. 

4) Criminal law is a system of regulating the behavior of individuals and groups in relation to societal nouns . 

80- The basic course in criminal law in most North American law schools is based on the ................. 

1) English common criminal law of the mid-18th century 

2) English common civil law of the mid-18th century 

3) English common civil law of the mid-17th century 

4) English common criminal law the mid-17th century 

 هوش و توانمندی عمومی 

پاسخنامه علامت  انتخاب کنید و در    ۸۴تا    ۸1راهنمایی: متن زیر را به دقت بخوانید و صحیح ترین پاسخ را برای سؤال های  

 بزنید.

پایان قرن بیستم و آغاز هزاره جدید میلادی، نه تنها برای دانشمندان علوم اجتماعی و هواداران جنبش های هزاره ای، که  

برای عموم مردم، حاوی معانی و اشارات ضدّ و نقیض بود. بسیاری گمان میکنند پایان هزاره باید آبستن تحولی جدی باشد. 

ن هزاره نخست، بی هیچ حادثه ای سپری شد. با این همه، پایان هزاره دوم، واقعاً دوران  حال آنکه لزوماً این گونه نیست: پایا
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ارناپذیر و کتحول است. بدون تردید ما امروز در انقلابی ترین دوره تاریخ به سر میبریم و تغییر و تحول دائمی، به واقعیت ان

 اساسی حیات اجتماعی بدل شده است. 

عملاً در تمامی طول تاریخ بشر، آهنگ تغییر اجتماعی نسبتاً کند بوده است و اکثر مردم، کم و بیش، همان شیوه های زندگی 

پدرانشان را دنبال میکرده اند، حال آنکه امروزه برعکس، ما در جهانی متحول و دستخوش دگرگونی چشم گیر و دائمی زندگی  

رویداد دنیای معاصر را میتوان سرعت بی سابقه تغییرات اجتماعی دانست. روند میکنیم. به قسمی که شگفت انگیزترین  

تغییرات اجتماعی چنان سرعت و عمقی یافته که پابرجاترین عرصه حیات، بشر، یعنی فرهنگ را نیز در نوردیده و ما را در 

بارلو آن را جدی ترین تحو  تاکنون  میانه یک دگرگونی جدی فرهنگی قرار داده است. تحولی که  از کشف آتش  ل فرهنگی 

میداند. آنچه زمین چنین تغییر و تحولات ژرف و شگرفی را پدید آورده و این برهه از تاریخ را واجد برجستگی و اهمیت فوق  

نوین   های  تکنولوژی  عنوان  به  که  دستاوردهایی  است؛  بشری  متأخر  و  جدید  تکنولوژیک  دستاوردهای  ساخته،  ای  العاده 

تی شناخته میشود. از این رو، برخی خبر از استیلای یک پارادایم تکنولوژیک جدید میدهند که بر محور تکنولوژی  اطلاعا-ارتباطی

های اطلاعاتی سازمان یافته است. حال اگر بپذیریم که دگرگونی در تکنولوژی های ارتباطی موجب دگرگونی فرهنگی شده 

ژی های جدید ارتباطی که تناسبی با فرهنگ پیشین ندارند، فقدان است، باید به تأسی از مک لوهان اذعان داریم تکنولو

با  تأخر فرهنگی موجب پیدایی بحرانی فرهنگی میشود که همراه  یا  این فقدان تجانس  با دوام میآفرینند.  تجانسی نسبتاً 

و یکم با بهره گیری از  اطلاعاتی سده بیست  - دگرگونی های اجتماعی بروز و ظهور پیدا میکند. بدین ترتیب، انقلاب ارتباطی

تکنولوژی های نوین ارتباطی و اطلاعاتی و با فراهم آوردن مکان پیدایی »جامعه شبکه ای« که افراد و جوامع را در قالب های  

تازه هویت های تازه بخشیده، نه تنها قواعد و قوانین حاکم بر ارتباط میان انسان ها، بلکه ایستار ما را نسبت به خود، دیگران  

جهان تغییر داده است. به عبارت دیگر، با در هم شکستن مرزهای مرسوم گروهی و متعاقب آن، تغییر در برجستگی نسبی و  

 نیاز به نشانه و تمایز، بر روشنی و اهمیت مرزبندی های گروهی و در نتیجه معنای هویت اجتماعی تأثیر گذاشته است. 

 موضوع اصلی متن فوق، کدام است؟  -۸1

 ( تحولات اجتماعی و فرهنگی قرن بیستم ۱

 اطلاعاتی  –( تکنولوژی های نوین ارتباطی ۲

 ( پیامدهای تحولات اجتماعی و تکنولوژیک ۳

 ( معانی ضدّ و نقیض تحول در عرضه های اجتماعی و فرهنگی۴

 براساس متن، کدام مورد در خصوص سرعت تغییرات اجتماعی، صحیح است؟  -۸۲

 ( آثار منفی در شیوه های زندگی انسان ها برجا گذاشته است. ۱

 ( تابعی از پیشرفت های تکنولوژیک عصر حاضر است. ۲

 ( از نظر بارلو، غیرقابل کنترل و آسیب زا است. ۳

 ( از کشف آتش تاکنون، به طرز چشم گیری افزایش یافته است. ۴
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 هدف نویسنده از اشاره کردن به مک لوهان در پاراگراف دوم، کدام است؟  -۸۳

 نمودن نظر او درباره یک مقوله فرهنگی ( مشروط ۱

 ( ارائه تعریف پدیده فقدان تجانس فرهنگی ۲

 ( استفاده از دیدگاه او در بیان نظر خویش ۳

 ( معرفی او به عنوان یکی از صاحب نظران حوزه فرهنگ ۴

 براساس متن، کدام مورد درباره رابطه بین دگرگونی های اجتماعی و فرهنگی، صحیح است؟  -۸۴

 ( دگرگونی فرهنگی در عصر حاضر، معلول سرعت گرفتن آهنگ تغییرات اجتماعی است. ۱

 ( انقلاب تکنولوژیک از استحکام این رابطه تا حدّ قابل توجهی کاسته است. ۲

 ( شواهدی دال بر وجود رابطه علت و معلولی بین آن ها وجود ندارد. ۳

 تغییرات فرهنگی ملموس بوده اند.( در طول تاریخ، تغییرات اجتماعی همواره عامل بروز ۴

، لازم است موقعیتی را که در هر سؤال مطرح شده، مورد تجزیه و تحلیل  ۸۸تا    ۸۵راهنمایی: برای پاسخگویی به سؤال های  

قرار دهید و سپس گزینه ای را که فکر میکنید پاسخ مناسب تری برای آن سؤال است، انتخاب کنید. هر سؤال را با دقت  

در هر سؤال و نتایجی که بیان شده و بیان نشده ولی قابل استنتاج است، بخوانید و با توجه به واقعیت های مطرح شده  

 پاسخی را که صحیح تر به نظر میرسد، انتخاب و در پاسخنامه علامت بزنید. 

بهتر است تیم سازنده فیلم »الف«، برای ساخت فیلم بعدی، مخاطب را هوشمندتر از چیزی که میپندارند در نظر بگیرند   -۸۵

و راه فیلم هوشمندانه تری چون »ب« را پیش بگیرند، چراکه مخاطب امروزی در کنار کشت و کشتار هیولاها و جلوه های 

 ر میخواهد.ویژه بی نظیر، دلش یک داستان ناب و اصلی ت

 کدام مورد را میتوان به درستی از متن فوق، استنباط کرد؟

 ( تیم سازنده فیلم »الف«، مورد توجه خاص مخاطبینی قرار گرفت که عاشق جلوه های ویژه هستند.۱

 کند. می ( این داستان و محتوای فیلم است که کشت و کشتار هیولاها و جلوه های ویژه بی نظیر را باورپذیر۲

( مخاطب های هوشمند، مادامی که داستان یک فیلم ناب و واقعی باشد، اهمیت چندانی به هیجان و جلوه های ویژه ۳

 نمیدهند 

 ( فیلم »ب«، فیلمی است که مطرح داستان آن قوی است. ۴

مریخ نورد ناسا، تصویری را از سطح سیاره سرخ ثبت کرده که نشان دهنده یک قاشق بزرگ و عجیب است. شکارچیان   -۸۶

فرازمینی ها اعتقاد دارند که این قاشق، نشانه ای از وجود حیات در مریخ در سال های دور بوده است. همچنین این کشف  

یه جان براندنبورگ، دانشمند مشهور در زمینه فضایی و فرازمینی ها را تأیید کند. براندنبورگ معتقد است که  ضمیتواند فر 

 حیات هوشمند در مریخ، در گذشته بر اثر یک جنگ هسته ای نابود شده است. 

 براندنبورگ است؟ کدام مورد، فرض لازم برای باورپذیری فرضیه جان 
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 دهد، ساخته فتوشاپ است. می ( قاشقی که مریخ نورد ناسا نشان۱

 ( مواد لازم برای تهیه سلاح های اتمی، در پوسته مریخ وجود داشته است. ۲

 ( مریخی ها از نظر تکنولوژیکی از انسان های کره زمین پیشرفته تر بودند. ۳

 خورده اند. می ( موجودات مریخی به مانند انسان غذا۴

ما میدانیم که آلودگی هوا به بیماری های قلبی، سکته مغزی و سرطان ارتباط دارد. حالا یک مطالعه جدید که نتایج آن    -۸۷

در ژورنال همتانگر منتشر شده، نشان میدهد که حتی مقادیر کم افزایش آلاینده، همبستگی زیادی با افزایش چشم گیر  

سال را برای این تحقیق، مورد   1۸هزار فرد زیر    ۵00ققان در سوئد، بیشتر از  ناراحتی های روحی در افراد جوان دارد. مح

بررسی و پایش قرار دادند. آن ها غلظت آلاینده ها در هر منطقه را با میزان داروهای اعصابی که برای کودکان تجویز شده  

ن مکان هایی بودند که افراد جوان در آن،  بود، تطبیق دادند. مکان هایی که میزان آلودگی شان بیشتر شده بود، تقریباً هما

 بیشترین نسخه ها را برای داروهای اعصاب دریافت کرده بودند. 

 کدام مورد، در صورتی که صحیح فرض شود. به بهترین وجه، استدلال فوق را تضعیف میکند؟

( در کشورهای دیگر، به ویژه کشورهای صنعتی، نیز همبستگی بین آلودگی هوا و بیماری های اعصاب، نوعی همبستگی  ۱

 مثبت است. 

 ( آلودگی هوا احتمالاً تأثیرات منفی بسیاری بر سلامت انسان است که هنوز همه آن ها به طور دقیق، مشخص نشده اند۲

 ( برخی از ناراحتی های اعصاب، یا روان درمانی و بدون مصرف دارو قابل علاج هستند.۳

کارگری هستند و در آنجا والدین زمان کمی برای   –ی از سوئد که آلودگی هوا در آنها زیاد است، مناطقی صنعتی  ق( مناط۴

 برقراری ارتباط عاطفی با فرزندانشان دارند. 

تفکر لزوماً متکی به زبان نیست، یا دست کم متکی به زبانی متعارف که قابل تکلم باشد، اما میتوانیم از طریق تصور    -۸۸

کردن مناظر و تصاویر، الگوهای سه بعدی ژست های صادقی، حرکات سر و دست، هیجانات احساسی و هر چیز دیگری که  

 به جز زبان تجربه کرده ایم، ……………………. 

 کدام مورد، به منطقی ترین وجه، جای خالی در متن فوق را کامل میکند؟

 ( ارتباط ایجاد کنیم. ۲    ( زبان را جایگزین کنیم. ۱

 ( تفکر کنیم. ۴    ( دانش افزایی کنیم. ۳

 پاسخ دهید.  ۹۲تا  ۸۹راهنمایی: با توجه به اطلاعات زیر به سؤال های 

)نه لزوماً به ترتیب(، به درگاه خدمات الکترونیکی قضایی به منظور دریافت پنج خدمت   Eو    A  ،B  ،C  ،Dپنج کاربر با اسامی  

نوع خدمت  کنند. هر فرد دقیقاً یک  می  ارائه »دادخواست«، »شکوائیه«، »اظهارنامه«، »لایحه« و »درخواست عفو« مراجعه

کند و همزمان با او، کاربر دیگری به این درگاه مراجعه نمیکند. در خصوص ترتیب مراجعه این پنج نفر و نوع می  را دریافت

 خدمت دریافتی، اطلاعات و محدودیت های زیر، در دست است: 
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 *C  زودتر ازA  و بعد ازE کند.می که »درخواست عفو« نداده است، به درگاه مراجعه 

 Dو  Aمراجعه کرده است و نه بین  Dو  Eکه »شکوائیه« ارائه نموده، نه بین  Bکاربر * 

 دقیقاً قبل از وی به درگاه مراجعه کرده است.  Dکاربر آخر باشد،   Bاگر * 

فردی که در درگاه، »لایحه« ارائه نموده، دیرتر از کاربر ارائه دهنده »اظهارنامه« و قبل از کاربر ارائه کننده »دادخواست« به  *  

 کند. می این درگاه مراجعه

باشد که به درگاه خدمات الکترونیکی قضایی مراجعه و »درخواست عفو« را ارائه  ، دومین کاربر بین این پنج کاربر  Dاگر   -۸۹

 میکند، کدام کاربر، سومین مراجعه کند و به این درگاه است؟ 

۱ )C   ۲ )D   ۳ )E   ۴ )A 

چنانچه ارائه »لایحه « و »درخواست عفو«، به ترتیب، دومین و سومین موردی  باشد که در درگاه خدمات الکترونیکی   -۹0

 قضایی ثبت شده است، کدام دو نفر زیر، به ترتیب مراجعه کنندگان چهارم و پنجم به این درگاه هستند؟ 

۱ )A  وD  ۲ )D  وB  ۳ )C  وD  ۴ )C  وA 

با ارائه لایحه، سومین نفری باشد که به درگاه خدمات الکترونیکی قضایی مراجعه میکند. خدمت دریافت شده    Cاگر    -۹1

 توسط مراجعه کننده پنجم، کدام است؟ 

  ( دادخواست ۲     ( شکوائیه ۱

 ( عفو۴    ( نمی توان تعیین کرد. ۳

، با کدام Eو   Bدو کاربری باشند که دقیقاً پشت سر هم به درگاه خدمات الکترونیکی قضایی مراجعه میکنند،   Eو   Bاگر    – ۹۲

 ترتیب به این درگاه مراجعه میکنند؟

 ( اول و دوم ۴ ( چهارم و پنجم ۳  ( سوم و چهارم ۲  ( دوم و سوم ۱

 را به دقت بخوانید و جواب هر سؤال را در پاسخنامه علامت بزنید.  ۹۷تا  ۹۳راهنمایی: هر کدام از سؤال های 

 کدام است؟  X + Y. در جدول روبه رو، حاصل ۹۳

۱ )۱۰ 

۲ )۸ 

۳ )۷ 

۴ )۱۱ 

% نیز ۳0لیتری آب و آب لیمو به غلظت    ۶% در اختیار داریم، یک محلول  ۴0لیتری آب و شکر به غلظت    ۴یک محلول    -۹۴

 داریم. این دو محلول را با هم ترکیب میکنیم تا شربت آبلیمو ساخته شود. غلظت شربت آبلیمو چند درصد است؟ در اختیار 

۱ )۳۴   ۲ )۳۵   ۳ )۳۶   ۴ )۳۳ 

3 0 5 6 

2 8 7 4 

4 5 5 9 

y x 8 8 
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اردیبهشت دوشنبه باشد، فردا چند شبه   10خرداد میگذرد. اگر    1۵امروز، پس فردای روزی است که سه هفته از    فکر ن- ۹۵

 خواهد بود 

 ( سه شنبه ۴  ( جمعه ۳  ( پنج شنبه۲  ( چهارشنبه ۱

بود. تفاضل سن علی و دوستش چقدر   ۵/۳به    ۵سال پیش    10است. این نسبت    ۴به    ۵نسبت سن علی به دوستش    -۹۶

 است؟ 

۱ )۹   ۲ )۶   ۳ )۳   ۴ )۱۲ 

رسم میکنیم که دایره ای که به هر چهار  را طوری  ه مرکز چهار رأس یک مربع، چهار دایره یکسان  ب مطابق شکل رو به رو،    -۹۷

 خورده است؟ )فرض شود.( دایره میتواند مماس شود نیز با آن چهار دایره یکسان باشد. چند درصد مساحت سریع، هاشور

۱ )۴۰ 

۲ )۳۳ 

۳ )۲۵ 

۴ )۵۰ 

 پاسخ دهید.  100تا  ۹۸راهنمایی: با توجه به اطلاعات و نمودارهای زیر، به سؤالات 

است. نمودار »الف« درصد پرونده های ارجاع شده   ۵و    ۴،  ۳،  ۲،  ۱شعبه عمومی با شماره های    ۵حوزه قضایی شهری، دارای  

»جعل و کلاهبرداری« به کل پرونده های ارجاع شده به  در یک سال خاص به هر شعبه و نمودار »ب«، درصد پرونده های  

 دهد. می هر کدام از شعبه ها را در همان سال نشان

 
  ۴ارجاع شده باشد، چند پرونده غیر از »جعل و کلاهبرداری« به شعبه    ۵پرونده »جعل و کلاهبرداری« به شعبه    ۷0اگر    -۹۸

 ارجاع شده است؟ 

۱ )۱۶۰   ۲ )۱۴۵   ۳ )۲۵   ۴ )۲۴۰ 
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، چند درصد از کل پرونده های ارجاع شده به همه شعبه ها  ۴و    ۳پرونده های »جعل و کلاهبرداری« ارجاعی به شعب    -۹۹

 بوده است 

۱ )۵/۳۰  ۲ )۲۵ /۱۸  ۳ )۲۵/۱۵  ۴ )۵/۳۶ 

% کاهش یافته است. با فرض ثابت ماندن مقادیر دو نمودار »الف«  ۲0در سال بعد از آن، تعداد کل پرونده های ارجاعی    -100

 بوده است؟  1ارجاع شده اند، مربوط به شعبه  ۵و  1و »ب«، چند درصد از پرونده های »جعل و کلاهبرداری« که به شعب 

۱ )۵۵   ۲ )۴۵   ۳ )۲۵   ۴ )۷۵ 

 

https://iranarze.ir/es278
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 پاسخ  سوال پاسخ  سوال پاسخ  سوال پاسخ  سوال پاسخ  سوال پاسخ  سوال

1 2 24 4 47 4 70 3 93 1   

2 4 25 3 48 1 71 4 94 1   

3 1 26 1 49 3 72 2 95 3   

4 4 27 2 50 4 73 3 96 2   

5 3 28 3 51 2 74 1 97 3   

6 3 29 4 52 1 75 4 98 1   

7 1 30 1 53 1 76 3 99 2   

8 2 31 4 54 2 77 2 100 4   

9 3 32 4 55 3 78 4     

10 2 33 2 56 2 79 2     

11 1 34 3 57 1 80 4     

12 3 35 1 58 2 81 1     

13 1 36 3 59 4 82 2     

14 1 37 4 60 3 83 3     

15 4 38 3 61 1 84 1     

16 3 39 2 62 2 85 4     

17 1 40 3 63 2 86 2     

18 2 41 4 64 3 87 4     

19 2 42 1 65 4 88 4     

20 3 43 3 66 1 89 3     

21 1 44 1 67 3 90 2     

22 3 45 2 68 2 91 3     

23 2 46 2 69 4 92 4     
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